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1  Introduction  
WinCanMap est un outil efficace utilisé pour le transfert de données à partir 
d’enregistrements SIG dans le logiciel WinCan d’inspection TV.  

Aucun logiciel de SIG spécial n’est nécessaire! L'afficheur géographique WinCanMap est 
disponible en tant que module WinCan.  

WinCanMap peut être aussi bien utilisé dans votre véhicule sur site qu'au bureau dans le 
cadre de la préparation d'une intervention. Un simple clic avec la souris permet de 
sélectionner un ou plusieurs tronçons ou regards de visite ; il vous suffit ensuite d'appuyer 
sur un bouton pour transférer les données des enregistrements SIG dans le rapport tête de 
tronçon ou regard de visite du projet WinCan. De cette manière, l'opérateur peut 
économiser de nombreuses heures d'écriture. En outre, les erreurs de transfert sont 
pratiquement exclues. En outre, un bouton permet de naviguer vers les tronçons du projet 
WinCan à partir de l'interface géographique. 

1.1  Configuration système requise 
En ce qui concerne la structure et la capacité du système, WinCanMap requiert les mêmes 
configurations que WinCan v8. Pour toute autre information relative à l'administration et à 
l'installation de WinCan8, veuillez vous référer au Manuel d'administration du système 
WinCan8. 

1.2  Installation 

1.2.1  Installation de WinCan 
Avant d'installer WinCanMap, vous devez vérifier que WinCan a été déjà installé sur 
l'ordinateur-cible. Exécutez ensuite WincCanMapSetup.exe. Veuillez suivre les instructions 
du programme d'installation. Le répertoire cible standard est C:\Program Files\WinCanMap. 

Pour toute autre information relative à l'administration et à l'installation de WinCan8, 
veuillez vous référer au Manuel d'administration du système WinCan8. 
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2  Démarrage et arrêt de WinCanMap 
WinCanMap peut être démarré de différentes manières, en fonction de la version de WinCan 
avec laquelle vous travaillez. 

2.1  Démarrage de WinCanMap pour WinCan v7.x 
Vérifiez que WinCan v7.x a déjà été démarré. Appuyez ensuite sur la barre de tâches de 
Windows Démarrer > Programmes >WinCan v7 > WinCanMap use only for WinCan 
v7 (à n'utiliser que pour WinCan v7)  

2.2  Démarrage de WinCanMap pour WinCan v8.x 
Démarrez tout d'abord WinCan v8 x et ouvrez/créez un projet. L'icône de WinCanMap 
apparaît sur la barre d'outils au milieu de l'image. Cliquez sur cette icône. 

2.3  Interface utilisateur 
L'interface utilisateur de WinCanMap est composée de trois sections. Dans la partie 
supérieure se trouvent les menus et la Barre d'outils (A). La partie médiane de la fenêtre, 
qui occupe le plus d'espace, est dédiée à l'Interface cartographique (B) ainsi qu'à la 
Légende de carte (C) qui peut être affichée ou masquée. Dans la partie inférieure de la 
fenêtre est affichée la Barre d'état (D) dans laquelle sont représentées les informations 
d'état comme les coordonnées cartographiques actuelles. 

 
Lors du premier démarrage du programme, l'interface utilisateurs apparaît à résolution 
réduite. Comme dans toutes les applications Windows, l'utilisateur peut agrandir et réduire 
la taille de la fenêtre. Il est également possible de déplacer la fenêtre sur un deuxième 
écran connecté en option. Ces paramétrages sont enregistrés pour les prochaines sessions 
de travail. 

2.4  Arrêt de WinCanMap 
Vous arrêtez le programme en cliquant sur Projet > Quitter. Un message vous demande 
alors si vous voulez vraiment quitter le projet. Les modifications que vous apportez dans un 
projet WinCanMap ne sont pas sauvegardées automatiquement. Il incombe à l'utilisateur de 
s'en charger avant de quitter le projet, voir chapitre 3.3 . 
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3  Travail avec le projet WinCanMap  
Par projet WinCanMap, on entend un ensemble de différents enregistrements qui forment 
ensemble la représentation cartographique. Ces enregistrements, appelés « layers » en 
anglais, peuvent se présenter sous différents formats et, en fonction du type de données, 
être utilisés comme « layers » de transfert ou servir uniquement d'orientation. Les projets 
WinCanMap sont enregistrés sous forme de documents XML dont le nom se termine 
par .xml.  

3.1  Création d'un nouveau projet 
Commencez par créer un projet en sélectionnant Projet > Nouveau. Une fenêtre s'ouvre 
alors, demandant si vous souhaitez charger un modèle. Un modèle est un projet 
WinCanMap déjà pourvu des enregistrements qui apparaissent régulièrement dans de 
nouveaux projets, par exemple des informations de base comme des plans de ville. 

Si vous appuyez sur Annuler, l'opération est annulée.  

Si vous optez pour Oui, la boîte de dialogue Öffnen [Ouvrir] apparaît. L'utilisateur peut 
choisir un modèle sous format XML. Apparaît alors la boîte de dialogue Speichern 
[Enregistrer]. Vous pouvez définir ici le nom du fichier du nouveau projet WinCanMap, ainsi 
que l'endroit où vous souhaitez l'enregistrer. Le nouveau projet s'ouvre. 

Si vous optez pour Non, la boîte de dialogue Speichern [Enregistrer] apparaît. Vous pouvez 
définir ici le nom du fichier du nouveau projet WinCanMap, ainsi que l'endroit où vous 
souhaitez l'enregistrer. Le nouveau projet s'ouvre. Dans ce dernier cas, il s'agit d'un 
nouveau projet vide de toute information. 

3.2  Ouverture d'un projet existant 
Dans ce cas, sélectionnez Projet > Ouvrir. Dans la boîte de dialogue Öffnen [Ouvrir] qui 
apparaît alors, sélectionnez le fichier XML souhaité et cliquez sur OK. Le projet s'ouvre. 

Vous pouvez aussi sélectionner directement un projet dans la liste des projets WinCanMap 
qui ont été ouverts en dernier. Cette liste se trouve dans la partie inférieure dans le menu 
Projet. 

3.3  Enregistrement d'un projet ouvert 
Vous pouvez sauvegarder le projet WinCanMap sur lequel vous travaillez actuellement de 
deux différentes manières. Avec la commande Projet > Enregistrer, le projet est 
enregistré sous le même nom, c'est à dire que toutes les modifications opérées 
dernièrement sont sauvegardées. 

Avec la commande Projet > Engistrer sous, le projet est créé sous un autre nom. La boîte 
de dialogue Speichern [Enregistrer] apparaît, vous permettant de déterminer un nouveau 
nom de fichier et/ou un nouvel endroit pour l'enregistrer. 

3.4  Fermeture d'un projet 
Vous pouvez remettre à zéro l'interface cartographique en cliquant sur Projet > Fermer. 
Le projet est déchargé. Vous vous retrouvez alors dans le même état que directement après 
le démarrage de WinCanMap. 
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4  Travail avec les « layers » 
Vous venez de créer un projet WinCanMap. Il faut à présent le remplir avec des 
enregistrements géographiques. Ces enregistrements sont disponibles sous forme 
numérique, en tant qu'enregistrement vectorisé ou en tant qu'image. Les enregistrements 
géographiques se réfèrent au monde géographique, c'est-à-dire que n'importe quel lieu de 
l'enregistrement peut être mis en relation avec un endroit (coordonnées) du monde réel. 
Tous les enregistrements rassemblés dans un projet WinCanMap doivent être classés dans 
le même système de coordonnées, de manière à pouvoir être tracés de manière correcte les 
uns après les autres. Conformément à l'usage général, ces enregistrements seront 
mentionnés à présent sous la dénomination de Layer. En anglais, « layer » signifie Niveau 
de données. Le sens de ce mot montre déjà que tous les layers sont classés par couches 
successives à des niveaux différents. Cela signifie que le layer placé au premier plan peut 
éventuellement recouvrir les layers placés en dessous. 

4.1  Types de layers 

4.1.1  Layers vectorisés 
Par layers vectorisés, on entend des enregistrements dont les différents éléments sont 
représentés sous la forme de vecteurs. Actuellement, WinCanMap prend en charge les 
formats de vecteurs suivants : les shapefiles ESRI et les fichiers AutoCAD DXF. Les 
shapefiles et leurs données factuelles peuvent être utilisés en tant que layers de transfert 
(voir chapitre 7.1.1 ). Les fichiers DXF, en revanche, sont employés en tant que simples 
informations de base, comme les contours des bâtiments, les bords des routes etc. 

4.1.2  Layers basés pixels 
Par layers basés pixels, on entend des enregistrements dont le plus petit élément 
représente un pixel, c'est-à-dire un point de l'image ayant une forme carrée. Parmi les 
layers en pixels caractéristiques, on compte les prises de vue aériennes, les plans scannés 
etc. Les layers en pixels présentent un gros désavantage, à savoir que lors d'un zoom très 
rapproché, les différents points de l'image deviennent de plus en plus gros : il se forme 
comme des escaliers, et l'image n'est plus correctement visible que dans certains secteurs 
du zoom. Les layers en pixels ne peuvent être représentés dans une position adaptée sur ou 
sous d'autres layers que s'ils sont référencés du point de vue géographique. Veuillez vous 
informer à cet égard auprès du fournisseur de données. 

4.2  Ajout de layers 

En cliquant sur le bouton Ajouter niveau cartographique , vous faites apparaître la 
boîte dialogue Öffnen [Ouvrir]. Modifiez si besoin le Type de fichiers dans le menu 
déroulant dans la partie inférieure et sélectionnez le ou les fichier(s) que vous souhaitez 
ajouter au projet. Il est possible d'effectuer une sélection multiple. Pour ajouter la sélection, 
cliquez sur OK. 

4.3  Activation de layers 
Pour activer un layer, on le marque de manière à ce qu'il soit identifié comme layer actif 
pour les opérations suivantes. L'activation est effectuée dans la légende. Pour ce faire, 
faites apparaître cette dernière. Pour activer ensuite le layer, il vous suffit de cliquer sur son 
nom dans la légende. Le layer est alors mis en évidence. 

4.4  Modification d'ordre de succession des layers 
Si vous souhaitez modifier l'ordre de succession des layers, faites apparaître la légende. 
Attrapez ensuite un layer (en cliquant dessus avec le bouton gauche de la souris) et tirez-le 
jusqu'à l'endroit souhaité en maintenant le bouton gauche enfoncé. L'opération terminée, 
vous pouvez lâcher le bouton gauche de la souris. 
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4.5  Visibilité des layers 
Les layers peuvent être rendus visibles ou invisibles indépendamment les uns des autres. 
Pour ce faire, affichez la légende et cliquez sur l'encoche ou dans la case à cocher à gauche 
du nom du layer.  

4.6  Représentation des layers 
L'utilisateur a la possibilité d'influencer le type de représentation des différents layers 
vectorisés. Lors du premier ajout d'un layer au projet WinCanMap (voir chapitre 4.2 ), une 
représentation standard est automatiquement choisie. En général, l'utilisateur ajuste 
ensuite cette représentation en fonction de ses besoins. Ces ajustements sont enregistrés 
dans le projet WinCanMap (voir chapitre 3.3 ). Faites apparaître la légende et double-cliquez 
sur le nom du layer. La fenêtre Symbole Propriétés s'ouvre. Les propriétés suivantes 
peuvent être modifiées. 

4.6.1  Nom du layer  
Entrez un nouveau nom pour le layer dans la zone de texte. 

4.6.2  Couleur 
Si vous double-cliquez sur la couleur actuelle, la Boîte de dialogue Couleurs de Windows 
s'ouvre. Sélectionnez une nouvelle couleur et confirmez avec OK. 

4.6.3  Couleur de contours 
Cette propriété n'apparaît que dans le cas de layers de surface étendue, des bassins de 
peuplement par exemple. Cette propriété n'apparaît pas dans le cas de layers du type lignes 
ou points. Si vous double-cliquez sur la couleur actuelle, la Boîte de dialogue Couleurs de 
Windows s'ouvre. Sélectionnez une nouvelle couleur et confirmez avec OK. 

4.6.4  Symbole 
Cette propriété permet de modifier le symbole. Selon la caractéristique du layer (surfaces, 
lignes ou points) sont affichées différentes possibilités de sélection, telles que types de 
lignes, remplissages de superficies etc. 

4.6.5  Taille 
Par taille, nous entendons l'épaisseur de la ligne dans le cas d'éléments linéaires, la taille du 
symbole lors d'éléments de type point ainsi que la largeur de la ligne de contours lors 
d'éléments de type surface. Dans ce domaine, l'unité de mesure est le point. 

4.7  Zoom vers le layer activé 
Vous trouverez cette fonction sous Layer > Zoom vers le layer actif. Chaque layer 
possède une extension spatiale maximale. Avec cette fonction, la section cartographique est 
agrandie ou réduite de manière à cibler la représentation de cette section particulière.  

4.8  Suppression d'un layer 
Il est possible de supprimer un layer actif (voir chapitre 4.3 ) d'un projet WinCanMap en 
sélectionnant l'option de menu Layer > Suppression du layer actif. Si cette suppression 
est définitive, veillez à enregistrer maintenant le projet WinCanMap. 
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5  Navigation sur la carte 

5.1  Zoom d'approche 
En s'approchant avec le zoom, il est possible d'agrandir les détails d'une carte. L'étendue de 
la surface représentée est réduite au fur et à mesure que vous agrandissez le zoom. Pour ce 

faire, sélectionnez le bouton Agrandir la section de carte.  Sur la superficie de la carte, 
dessinez un rectangle en tenant enfoncé le bouton gauche de la souris. La section de carte 
est alors modifiée de manière à ce que le rectangle vienne occuper toute la surface de la 
carte. 

5.2  Zoom d'éloignement 
Avec le zoom d'éloignement, la taille des détails représentés se réduit. Pour ce faire, 

sélectionnez le bouton Réduire la section de carte  Avec le pointeur de la souris, 
cliquez n'importe où sur la carte. La section de carte est alors modifiée de manière à ce que 
l'endroit sur lequel vous avez cliqué se trouve à nouveau au milieu de la carte et soit réduit 
d'un facteur de zoom. 

5.3  Déplacer 
La section de carte peut être aussi déplacée sans faire de zoom. Pour ce faire, sélectionnez 

le bouton Déplacer la section de carte  Sur la carte, déplacez la section actuelle vers 
un nouvel endroit en tenant enfoncé le bouton gauche de la souris. Lorsque vous relâchez le 
bouton de la souris, les sections manquantes sont chargées. 

5.4  Zoom sur l'ensemble de la carte 
Si vous utilisez cette fonction, la section de carte sera zoomée de manière à faire apparaître 
tous les layers dans leur intégralité, à condition toutefois qu'ils aient été mis en mode 
« visible », voir chapitre 4.5 . Pour ce faire, utilisez le bouton Voir l'ensemble de la carte] 

 

5.5  Zoom vers des coordonnées 
Cette fonction accorde la possibilité de sauter vers des coordonnées connues de la carte, 
par exemple les coordonnées de la plaque de recouvrement d'un regard de visite. Cliquez 

sur le bouton Sauter vers les coordonnées XY.  La boîte de dialogue Aller vers 
apparaît à l'écran. Entrez les valeurs recherchées X et Y des coordonnées et confirmez par 
OK. La section de carte est déplacée de manière à ce que les coordonnées se trouvent à 
présent au milieu de la carte, sans qu'un zoom ait eu lieu pour autant. Le point 
d'intersection des coordonnées s'éclaire brièvement.  
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6  Autres fonctions 

6.1  Requête sur les objets 
Comme décrit dans le chapitre 4.1 , les layers vectorisés disposent généralement, outre les 
simples informations concernant la géométrie des objets, de données factuelles permettant 
d'obtenir une description détaillée des objets. Dans le cas d'un cadastre des canaux, il s'agit 
par exemple d'informations sur les profils, les sections, les années de construction. 

Pour trouver les différentes informations factuelles relatives à un objet, sélectionnez l'outil 

Faire une requête sur les objets , puis cliquez sur n'importe quel objet situé sur la 
carte. Une boîte de dialogue s'ouvre alors, affichant les informations requises.  

6.2  Enregistrement d'une carte en tant qu'image 
matricielle 
La section de carte visible en ce moment peut être enregistrée sur le disque dur sous la 
forme d'un fichier d'image matricielle. Pour ce faire, sélectionnez l'outil Enregistrer la 
section de carte en tant qu'image matricielle . La boîte de dialogue Speichern 
[Enregistrer] s'ouvre. Choisissez le lieu d'enregistrement et le nom du fichier et confirmez 
par OK. 

6.3  Impression de la carte 
La section de carte actuellement visible peut être imprimée sur l'imprimante définie comme 
imprimante standard. Pour ce faire, sélectionnez l'outil Envoyer la section de carte à 
l'imprimante standard . 

6.4  Connexion GPS 
La section de carte peut être aussi couplée au système de positionnement par satellite GPS 
(global positioning system). Equipement requis : un appareil GPS apte à communiquer 
en permanence la position actuelle, conformément au standard NMEA 0183. Les 
paramétrages peuvent être effectués dans Options > GPS. La boîte de dialogue 
Paramétrages GPS apparaît à l'écran.  

 

6.4.1  Système de coordonnées GPS 
Indiquez dans quel système de coordonnées le récepteur GPS communique les données via 
l'interface NMEA 0183. Pour des raisons de simplicité, cette interface devrait être 
paramétrée en fonction d'un système de coordonnées géographiques valable dans le monde 
entier, par exemple le WGS 1984 (= world geodetic system / système mondial géodésique 
1984).  

6.4.2  Projection 
Ce paramétrage indique le système dans lequel les données sont représentées sur la carte. 
Il s'agit dans ce cas du même système que celui appliqué par les autres layers, à savoir 
habituellement un système de coordonnées nationales, par exemple Gauss-Krüger, 
Schweizerisches Landeskoordinatensystem CH1903. 



Autres fonctions 

Page 11/14 

6.4.3  Transition ellipsoïdale 
Dans le cas de transformations complexes des systèmes de coordonnés, il peut s'avérer 
nécessaire de définir une conversion entre deux corps de référence : c'est ce qu'on appelle 
une transition ellipsoïdale. Si vous souhaitez des informations plus détaillées sur la 
transition ellipsoïdale, veuillez vous adresser au fournisseur de données. 

6.4.4  Interface sérielle 
Indiquez le numéro de l'interface sérielle à laquelle le récepteur GPS est connecté.  

6.4.5  Activation/Désactivation 
Lorsque les paramétrages ont été correctement effectués, il est possible de représenter à 
l'écran la position actuelle du récepteur GPS. Pour ce faire, activez le bouton GPS , ou 
appuyez une nouvelle fois sur le bouton pour désactiver. 
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7  Interaction avec WinCan 
* Ces sections se réfèrent uniquement à WinCan v8.x 

7.1  Transfert de données 
Le transfert de données constitue une des fonctions principales de WinCanMap. Il importe 
de reporter dans le projet WinCan les données factuelles existantes relatives aux layers. De 
cette manière, il est possible de compléter rapidement, avec facilité et sans aucune erreur, 
les informations de base concernant les tronçons et les regards de visite, avec des données 
qui ont déjà été enregistrées dans le système SIG. On peut ainsi éviter des erreurs 
d'écriture, aucune information erronée ne n'est affichée sur l'image vidéo, et l'opérateur 
peut se concentrer sur l'inspection proprement dite. 

7.1.1  Layer de transfert 
Par layer de transfert, on entend un layer vectorisé (voir chapitre 4.1.1 ), dont les 
informations factuelles doivent être transmises dans un projet WinCan. En général, il 
s'agit des informations de base relatives aux tronçons et aux regards de visite. Afin qu'il 
soit possible d'établir un classement précis, il importe que chaque objet du layer de 
transfert, qu'il s'agisse de tronçons ou de regards de visite, soit doté d'une identification 
précise, sous la forme d'un nombre ou d'une dénomination, que nous mentionnerons par la 
suite sous le terme de ID. 

7.1.2  Paramétrages 
En règle générale, chaque utilisateur possède des layers très différents au niveau de la 
structure et des contenus. Il importe donc que le système reste aussi flexible que possible. 
Tous les paramètrages relatifs au transfert peuvent être établis dans Options > Transfert. 
Tous les paramètres sont enregistrés dans le projet WinCanMap. 

 
Le Nom du projet désigne le projet. Il est établi à partir du nom du fichier.  

Le Chemin du projet représente le lieu d'enregistrement et le nom du fichier du projet 
WinCanMap. 

Ces deux propriétés ne peuvent pas être modifiées dans cette boîte de dialogue. 
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Le Layer de tronçon est le layer contenant toutes les données factuelles spécifiques au 
tronçon.  

Le Champ du tronçon correspond, dans le tableau de valeurs du layer de transfert, à la 
colonne qui contient l'identification précise de chaque tronçon. 

Le tableau suivant permet d'établir l’attribution des contenus des colonnes du layer de 
tronçon à des colonnes dans le projet WinCan. Il est ainsi possible d'établir quelles 
informations doivent être transférées dans quelles colonnes de la tête de tronçon WinCan.  

Le Layer de regard de visite est le layer contenant toutes les données factuelles 
spécifiques au regard de visite.  

Le Champ du regard de visite correspond, dans le tableau de valeurs du layer de 
transfert, à la colonne qui contient l'identification précise de chaque regard de visite. 

Le tableau suivant permet d'établir l’attribution des contenus des colonnes du layer de 
regard de visite à des colonnes dans le projet WinCan. Il est ainsi possible d'établir quelles 
informations doivent être transférées dans quelles colonnes de la tête de regard de visite 
WinCan.  

7.1.3  Sélection 
Il est possible d'opérer une sélection graphique des objets qui doivent être transférés dans 

WinCan. Pour ce faire, l'utilisateur dispose de quatre outils dans la barre d'outils. . 
Sélectionnez un des outils, le pointeur de la souris change de forme. En fonction de l'outil 
choisi, vous pouvez opérer différents types de sélection des objets du layer de transfert 
dans l'interface cartographique. Avec la combinaison de touches Ctrl-A, vous pouvez 
sélectionner tous les objets. 

 

7.1.4  Transfert 

En cliquant sur le bouton Déplacer des données vers WinCan , vous pouvez transférer 
les objets sélectionnés du layer de transfert dans un projet WinCan déjà ouvert. Lors de 
cette opération, il est contrôlé au moyen du champ de tronçon ou du champ de regard de 
visite (voir chapitre 7.1.2 ) si l'objet en question est déjà contenu dans le projet. Si c'est le 
cas, ses informations sont remplacées par celles qui viennent d'être transférées. Dans le cas 
contraire, un nouvel enregistrement est respectivement créé. 

Avant que les données ne soient transférées, une requête s'affiche pour demander si vous 
souhaitez l'attribution d'un véhicule. Si vous répondez par oui, la fenêtre Véhicule s'affiche à 
l'écran. Vous pouvez y sélectionner le véhicule adéquat. Lors de la nouvelle inspection, la 
dénomination du véhicule sera reportée dans WinCan dans le champ Véhicule. 

7.2  Recherche d'objets cartographiques dans WinCan* 
Vous pouvez trouver certains objets du layer de transfert dans le projet WinCan ouvert. 
Pour ce faire, sélectionnez l'outil Afficher des objets dans WinCan . Cliquez ensuite 
avec le bouton droit de la souris sur un objet. Si les champs de tronçon ou de regard de 
visite (voir chapitre 7.1.2 ) permettent de trouver cet objet dans le projet WinCan, WinCan 
vient se placer directement à l'endroit voulu.  

7.3  Recherche d'objets de base de données dans 
WinCanMap* 
Dans la carte, vous pouvez trouver certains objets des layers de transfert à partir du projet 
WinCan. Pour ce faire, cliquez dans WinCan avec le bouton droit de la souris sur les noms 
de regards de visite ou les noms de tronçons. Il doit s'agir des valeurs qui ont été 
paramétrées en tant que champs de tronçon ou de regard de visite dans le chapitre 7.1.2 . 
Si l'objet a été trouvé sur la carte, il clignote plusieurs fois. Si l'objet ne se trouve pas dans 
la section visible de la carte, cette dernière se déplace automatiquement.  
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7.4  Marquage des tronçons représentés dans WinCan* 
Tous les tronçons contenus dans la vue d'ensemble des tronçons WinCan peuvent être 
marqués sur la carte au moyen d'une commande. Pour ce faire, sélectionnez dans WinCan 
Outils > Afficher les tronçons dans WinCan Map. Tous les tronçons trouvés sont alors 
marqués. Cette fonction est particulièrement utile si elle est associée à WinCan & Filtres 
étendus. Si un sous-ensemble enduit par le filtre est représenté, ce sous-ensemble sera 
ensuite représenté dans WinCanMap. 

7.5  Contrôle du stade du projet* 
Cette fonction sert à contrôler quels tronçons ont été déjà transférés dans le projet WinCan. 
En outre, elle vous permet de savoir lesquels ont été déjà inspectés. Ce contrôle ne peut 
avoir lieu que s'il existe une correspondance entre les dénominations des tronçons et les 
paramètres des véhicules. Dans WinCanMap, sélectionnez Légende > Stade du projet 
Tous les tronçons sont alors représentés en couleur (conformément aux couleurs de la boîte 
de dialogue Véhicule) Les tronçons inspectés sont représentés comme des lignes continues, 
alors que ceux qui ne sont pas inspectés sont en pointillés. Un tronçon est considéré comme 
inspecté à partir du moment ou au moins deux observations ont été enregistrées.  

7.5.1  Paramétrages véhicules 
Sélectionnez Options > Véhicules. La Boîte de dialogue Véhicule apparaît. Un tableau 
contenant des dénominations de véhicules et les couleurs correspondantes s'affiche à 
l'écran. Ouvrez la Boîte de dialogue Couleurs en double-cliquant sur une couleur. Vous 
pouvez alors choisir une autre couleur, puis la confirmer. Si vous double-cliquez sur la 
dénomination d'un véhicule, cette dernière se retrouve en mode Edition et vous pouvez 
alors changer la dénomination. Le bouton Supprimer sert à supprimer une ligne et le 
bouton Ajouter à rajouter une ligne Si vous cliquez sur OK avant de fermer la boîte de 
dialogue, les modifications seront enregistrées ; si vous ne le souhaitez pas, sélectionnez 
Annuler. 

 


